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Typographic Conventions 
 

Type Style Description 

Example text Words or characters that appear on the screen. These include field 
names, screen titles, pushbuttons as well as menu names, paths and 
options. 

Cross-references to other documentation. 
Example text Emphasized words or phrases in body text, titles of graphics and tables.

EXAMPLE TEXT Names of elements in the system. These include report names, 
program names, transaction codes, table names, and individual key 
words of a programming language, when surrounded by body text, for 
example, SELECT and INCLUDE. 

Example text Screen output. This includes file and directory names and their paths, 
messages, source code, names of variables and parameters as well as 
names of installation, upgrade and database tools. 

EXAMPLE TEXT Keys on the keyboard, for example, function keys (such as F2) or the 
ENTER key.  

Example text Exact user entry. These are words or characters that you enter in the 
system exactly as they appear in the documentation.  

<Example text> Variable user entry. Pointed brackets indicate that you replace these 
words and characters with appropriate entries. 
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How to Use the New Features in DTW 2005 

Introduction 
This is a reference manual for SAP Business One Data Transfer Workbench 2005. Refer to Data 
Transfer Workbench for SAP Business One online help for the comprehensive documentation. 

 

 New Features in DTW 2005 
The following new and enhanced features have been included in DTW 2005: 

Data Import Wizard DTW 2005 has rearranged the steps in the Data Import Wizard, which 
enables you to import the data files into SAP Business One. 

Transform Table  
(New Feature) 

DTW 2005 provides the Transform Table feature so that to enable value 
mapping. 

Schedule Run      
(New Feature) 

DTW 2005 provides the Schedule Run feature that allows you to import 
or update data automatically. You may write a script file and schedule 
this script file to import data. 

Load Data from ODBC 
(New Feature) 

DTW 2005 can load data from ODBC as source data. 

Import Price Lists In DTW 2005, the behavior of the Import Price Lists function using the 
Item_Prices template has changed. 

 

The following data formats are different from DTW 2004: 

Data File Format DTW 2005 does not support the data file which contains both head and 
items together. 

DTW 2005 template does not include the Linetype column. 

Date Format DTW 2005 only supports one type of date format: YYYYMMDD. While 
DTW 2004 supports various date formats such as MM/DD/YYYY, MM-
DD-YYYY and so on. 

Enumerations Format DTW 2005 supports the member value of enumerations, and does not 
support the number value of enumerations which is used in DTW 2004. 
For example, you must use cCustomer instead of 0 for the CardType of 
BusinessPartners for customer. 
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How to Use DI API help 
Use 
DTW uses fields exposed by DI API. DI API online help which is a part of SDK online help can provide 
consistent and up-to-date information of an Object. 

Procedure 
1. Download or Install SDK to get the DI API online help (default file name: refdi.chm). The 

following two methods are available: 

a. Download the DI API online help from www.sdn.sap.com. Choose SAP Business One on 
the left. Under section Help, located on the right, choose SDK 2005 Help Center. In the 
Business One – SDK Documentation window, choose the link Help Center to download 
the zip file. 

b. Install SDK application from SAP Business One Setup CD. The SDK online help includes 
the DI API online help. You can find DI API online help in the Help folder of the SDK 
installation path. 

2. Open the DI API online help. 

3. On Content tab, expand Objects and the list of objects appears. 

4. Choose the specific object and expand Properties to show the detailed information. 

 
The fields in DTW template have the same name as that in the Object properties. 
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How to Use Data Import Wizard 
Use 
DTW 2005 rearranged the steps in the Data Import Wizard which enables you to import the data files 
into SAP Business One. 

Procedure 
1. Choose a Business Object. (DTW 2004 Data Import Wizard step 2) 

 
In general, the names of objects in the DTW and SAP Business One are either 
consistent or similar. The exceptions are as follows:  

- oInventoryGenEntry in DTW refers to Goods Receipt in SAP Business One. 

- oInventoryGenExit in DTW refers to Goods Issue in SAP Business One. 

- BoBridge in DTW refers to Exchange Rates in SAP Business One. 

- User-defined tables begin with U_. 

For more information, refer to the DI-API online help. 

2. Choose data files. (DTW 2004 Data Import Wizard step 3) 

 
You may get data through ODBC. For more information, refer to Loading Data from 
ODBC. 

3. Check source data, map rule and preview target data. (DTW 2004 Data Import Wizard step 4) 

DTW 2005 has three tabs (Source Data, Map Rule and Target Data), and DTW 2004 has two 
tabs (Data and Map). 

 
In this step, you can use Transform Table. For more information, refer to Transform 
Table. 

4. Choose a task type - import or update. (DTW 2004 Data Import Wizard step 1) Then select test 
run if you want to test run the import. You may configure rollback parameters. (DTW 2004 Data 
Import Wizard step 3) 

 
When an error occurs DTW can specify whether to rollback the records or not. 

In the Advanced dialog box, you can choose the option Rollback once an error happened 
to rollback all previous records, or choose No Rollback to keep the successful records. 

5. Preview configuration information including login, object code, file extractor, map and run. (DTW 
2004 provides file extractor information in the summary of step 5.) 

6. Choose Next to complete the data import. 
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 How to Generate and Upgrade Template 

 
The difference between the template of DTW 2005 and DTW 2004 is that the template for DTW 2005 
does not include the Linetype column. 

Use 
SAP Business One Data Transfer Workbench supports the import of text-based files that contain 
character separated values (*.csv or *.txt files). After you have successfully installed the Data Transfer 
Workbench, you can get predefined templates for each business objects. SAP recommends using the 
predefined templates to prepare the data files. 

A template is the fundamental frame for data file. Each template is related to a certain object. If an 
object has sub-objects, every sub-object also has a template. A template has two rows. The first row is 
made up of the properties from DI API. The second row is the explanation of the property. 

Procedure 
1. On the SAP Business One Data Transfer Workbench Main Menu, choose Advanced → Maintain 

Interface. 

2. On the Maintain Interface screen, choose the object. 

 
In the default situation, each object includes fields that are most commonly used. To 
change the default fields, you can right-click a field and choose Add Item or Delete Item.  

3. Right-click the object or sub-object, choose Create Template for the Structure, and set the path 
to save the template. 
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How to Import Failed Records 

 
This feature is provided starting from DTW 2005.0.3. The earlier three versions (DTW 2005.0.0, DTW 
2005.0.1 and DTW 2005.0.2) generate error files of XML style. 

Use 
The SAP Business One Data Transfer Workbench can store any failed records to a folder, so that you 
can correct and import them again. 

Procedure 
1. In the Detailed Log dialog box, if there are failed records, choose the Error File button to open 

the folder. 

2. Open the files within the folder, check the failed records, and correct them. 

3. Use DTW to re-import the correct files. 
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How to Adjust Data Format in DTW 2004 Template 

 
The following table contains the differences in data format between DTW 2005 and DTW 2004: 

Data File Format DTW 2005 does not support the data file which contains both head and 
items together. 

DTW 2005 template does not include the Linetype column. 

Date Format DTW 2005 only supports one type of date format: YYYYMMDD. While 
DTW 2004 supports various date formats such as MM/DD/YYYY, MM-
DD-YYYY and so on. 

Enumerations Format DTW 2005 supports the member value of enumerations, and does not 
support the number value of enumerations which is used in DTW 2004. 
For example, you must use cCustomer instead of 0 for the CardType of 
BusinessPartners for customer. 

Use 
Since DTW 2005 uses XML interface of DI API, the data file in DTW 2004 template cannot be used 
directly in DTW 2005. It is necessary to make some changes to the data files in DTW 2004 template 
before importing them into DTW 2005. 

Procedure 
1. If the file contains both head and item data, split the header and item data in different files. 

 You can write a VBA script to split the data file automatically based on Linetype 
column in Excel. 

2. Delete the Linetype column in the data files of the object or sub-object. 

3. Make sure the date format is YYYYMMDD. For example, the format for Feb 21, 2005 is 
20050221. 

4. Change the value of the enumeration type field. For more information, refer to Enumerations. 

 You can also use the mapping function to maintain a mapping table for 
enumerations between DWT 2004 and DTW 2005. For example, you may define a 
Transform Table for CardType. For more information, refer to Transform Table. 

Example  
Sample Data File of the object BusinessPartners in DTW 2004 Template: 

Linetype RecordKey CardCode CardType CardName ExpirationDate 
  RecordKey Code Type Name ExpirationDate 
H 1 SAP 0 SAP Corp  12/31/2008 

The steps of changing it to fit for DTW 2005 are as follows: 

1. Delete the Linetype column. 

2. In the field ExpirationDate, change the date format from 12/31/2008 to 20081231. 

3. Change the value in the field CardType from 0 to cCustomer. 

Updated data file: 
RecordKey CardCode CardType CardName ExpirationDate 
RecordKey Code Type Name ExpirationDate 

1 SAP cCustomer SAP Corp  20081231 
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 How to Set the Enumerations (OSS Note 866441) 
Use 
According to the requirement of DI API standard data format, all the enumeration type fields should be 
in the enumerations list. You can refer to the information in the DI API online help to enter 
enumerations. 

Procedure 
1. Open the DI API online help and find the object. 

2. Get the enumerations for the field according to the Syntax. 

3. Get the list of the enumerations. 

4. Select a Member in the list. 

Example  
In the object BusinessPartners, if you want to enter a customer type in the field CardType, the steps 
are as follows: 

1. In Contents tab of the DI API online help, choose Objects → BusinessPartners Object → 
Properties → CardType Property. 

2. In the Syntax, it displays the enumerations: BoCardTypes. Choose the hyperlink to get the 
detailed information. Alternatively, you may access the information by choosing Enumerations 
→ BoCardTypes Enumeration. 

3. In the field Members, it shows that cCustomer represents a customer, cSupplier represents a 
vendor and cLid represents a potential customer or vendor. 
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How to Get the Field Name in DI API 
Use 
Some field names in DI API are different from those in SAP Business One, since DTW is based on DI 
API and comply with name rule of DI API, some field names of DTW may be different from those of 
SAP Business One. For those field names of a DTW data file which are different from SAP Business 
One, you may look up the DI API online help to get the corresponding fields.  

A convenient method to get the field name of DI API is from the debug information in the status bar. To 
view the debug information, choose View → System Information, and then place the cursor on the field. 

Examples 
• In most checkboxes of SAP Business One, the database stores Y to represent checked and N 

to represent unchecked. DI API adopts tYes to represent checked and tNo to represent 
unchecked. 

• The field CardCode in the database represents the field Code of Business Partners in the user 
interface of SAP Business One. 
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How to Set Segmentation Accounts 
Use 
There are two account types in SAP Business One. Some countries such as the US, adopt 
segmentation accounts; others such as Germany, adopt non-segmentation accounts. SAP Business 
One adopts account code keys to identify the segmentation accounts in the database. When referring 
to an account, you can use account code key in SAP Business One instead of account code.  

For a non-segmentation account, the account code key (for example, 9000) is normally the same as 
the account code (9000). But for a segmentation account, the account code key (for example, 
_SYS00000000010) is not the same as the account code (12100000100101). You need to find out the 
account code key from the OACT table. 

Procedure 
1. On the SAP Business One Main Menu, choose Reports → Query Generator. 

2. In the field Select, enter AcctCode. 

3. In the field From, enter OACT. 

4. In the field Where, enter a conditional sentence for FormatCode. 

5. Choose Execute button and get the AcctCode value. 

Example  
If you want to import a BusinessPartner record with DebitorAccount field 12100000100101, the steps 
for searching AcctCode are as follows: 

1. On the SAP Business One Main Menu, choose Reports → Query Generator. 

2. In the field Select, enter AcctCode. 

3. In the field From, enter OACT. 

4. In the field Where, enter the conditional sentence FormatCode = ‘12100000100101’. 

5. Choose Execute button and you will get the AcctCode value: _SYS00000000010. 

 
You can use the mapping function to maintain a mapping table between account code 
key and account code. You can define a mapping table as the example of Transform 
Table. 
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How to Use Transform Table (OSS Note 908041) 
Use 
The SAP Business One Data Transfer Workbench provides the Transform Table function so that data 
can be transformed according to the table.  

Procedure 
1. In the step 3 of Data Import Wizard, select the Map Rule tab. From the Target Fields drop-down 

list, choose [Transform Table]; a Transform Table dialog box appears. 

2. In the Transform Table dialog box, choose . A Transform Table Management dialog box 
appears. 

3. In the Transform Table Management dialog box, choose Browse to select the plain text file 
which stores the transform table, and then enter a name to the field Transform Table Name. 

Then choose . 

 
You can make a plain text file as a transform table. Each row of the transform table has a 
source data and a target data, separated by a comma. 

4. In the Target Field Name drop-down list, select a target field to be transformed. In the 
Translation Table drop-down list, select a transform table. The path will appear in the field Table 

Path and the table will appear automatically. Then choose to return to the Data Import Wizard 
screen. 

Example  
You want to transform the AccountCode field of BPAccountReceivablePayble sub-object according to 
the table in the AccountCodeKey.txt file.  

The data file and the plain text file are as follows: 
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1. In the step 3 of Data Import Wizard, select the Map Rule tab. From the Target Fields drop-down 
list, choose [Transform Table]; a Transform Table dialog box appears. 

2. In the Transform Table dialog box, choose . A Transform Table Management dialog box 
appears. 

3. In the Transform Table Management dialog box, choose Browse to choose the 
AccountCodeKey.txt file and enter TransformAccountCodeKey to the field Transform 

Table Name. Choose . 

4. In the Target Field Name drop-down list, select the AccountCode to be transformed. In the 
Translation Table drop-down list, select TransformAccountCodeKey. The path will appear in 

the field Table Path and the table will appear automatically. Then choose to return to the 
Data Import Wizard screen. 
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How to Use Schedule Run (OSS Note 907940) 
Use 
The SAP Business One Data Transfer Workbench provides the Schedule Run function so that data 
can be imported or updated automatically. You may write a script file and schedule this script file to 
import data using DTW 2005. 

Procedure 
1. In step 5 of Data Import Wizard, choose to save the transfer configuration information to an 

XML file. 

2. Execute the command: 
DTW –s <Transfer File Path>[Transfer File Name] 

 
To schedule the run, choose Start→ All Programs → Accessories → System Tools → 
Scheduled Tasks, put the command to a script file such as ScheduleRunDTW.bat and 
arrange it as a scheduled task. 

Result 
You have arranged a schedule run to automatically import and update the data from a file into SAP 
Business One. 

Example  
1. In step 5 of Data Import Wizard, choose to save the transfer configuration information to the 

file C:\ScheduleRun\DTW\config.xml. 

2. Execute the command: 
DTW –s C:\ScheduleRun\DTW\config.xml 
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How to Load Data from ODBC (OSS Note 908042) 
Use 
SAP Business One Data Transfer Workbench can load data from ODBC as source data. 

Prerequisites 
1. Choose Control Panel → Administrative Tools → Data Sources (ODBC) to create a Data Source 

Name (DSN). 

2. Prepare the source data in a legacy database. 

Procedure 
1. In step 2 of Data Import Wizard, from the Source Data Type drop-down list choose ODBC. 

2. Select the object and choose Browse, the Extract by ODBC dialog box appears. 

3. From the DSN drop-down list, select a data source name. Then enter a user ID and password. 

4. In the field Simple Select Statement, enter the SQL statement to extract data from ODBC. To 

preview, choose .  

5. Choose to return to the Data Import Wizard screen.  

 
If the data files contain both header and item files, you must define the primary keys, 
such as RecodKey.  

For example, the SQL statement Select CardCode as RecordKey, * from OCRD can 
be applied to BusinessPartners; the SQL statement Select CardCode as RecordKey, * 
from CRD1 can be applied to BPAddresses. 

If the data files contain only header files, you do not need to define the primary keys. 

For example, the SQL statement Select * from OACT can be applied to the 
ChartOfAccounts. 

Example  
If you want to load data from MyOCRD table of MyDB database for BusinessPartners, MyCRD1 table 
for BPAddress, and the name of DSN is MyDSN, the steps are as follows: 

1. In step 2 of Data Import Wizard, choose ODBC from the Source Data Type drop-down list. 

2. Select BusinessPartners and choose Browse, the Extract by ODBC dialog box appears. 

3. From the DSN drop-down list, select MyDSN. Then enter a user ID and password. 

4. In the field Simple Select Statement, enter the SQL statement Select CardCode as 
RecordKey, * from MyOCRD. 

5. Choose . 

6. Select BPAddress and choose Browse, the Extract by ODBC dialog box appears.  

7. From the DSN drop-down list, select MyDSN. Then enter a user ID and password. 

6. In the field Simple Select Statement, enter the SQL statement Select CardCode as 
RecordKey, * from MyCRD1. 

7. Choose to return to the Data Import Wizard screen. 
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How to Import Price Lists (OSS Note 892949) 
Use 
In SAP Business One Data Transfer Workbench 2005, there is a change in the Item_Prices template 
used to populate price lists. The PriceListName and PriceList columns have been removed. 

Procedure 
To import or update price list information fill the LineNum field. 

Also, the LineNum field does not correspond to the position of the price list in the drop list of the Item 
Master Data window. The LineNum is the line number shown in the Price Lists window minus 1 (that is; 
0 for price list 1, 1 for price list 2 and so on). 

 

© SAP AG 2006 18  



SAP Business One Data Transfer Workbench How to Use the New Features in DTW 2005    

Copyright 
 

© Copyright 2005 SAP AG. All rights reserved. 
 

No part of this publication may be reproduced or transmitted in any form or for any purpose without the express 
permission of SAP AG. The information contained herein may be changed without prior notice. 

Some software products marketed by SAP AG and its distributors contain proprietary software components of 
other software vendors. 

Microsoft, Windows, Outlook, and PowerPoint are registered trademarks of Microsoft Corporation.  

IBM, DB2, DB2 Universal Database, OS/2, Parallel Sysplex, MVS/ESA, AIX, S/390, AS/400, OS/390, OS/400, 
iSeries, pSeries, xSeries, zSeries, z/OS, AFP, Intelligent Miner, WebSphere, Netfinity, Tivoli, and Informix are 
trademarks or registered trademarks of IBM Corporation in the United States and/or other countries.  

ORACLE® is a registered trademark of ORACLE Corporation. 

UNIX®, X/Open®, OSF/1®, and Motif® are registered trademarks of the Open Group. 

Citrix, ICA, Program Neighborhood, MetaFrame, WinFrame, VideoFrame, and MultiWin are trademarks or 
registered trademarks of Citrix Systems, Inc.  

HTML, XML, XHTML and W3C are trademarks or registered trademarks of W3C®, World Wide Web Consortium, 
Massachusetts Institute of Technology.  

JAVA® is a registered trademark of Sun Microsystems, Inc.  

JAVASCRIPT® is a registered trademark of Sun Microsystems, Inc., used under license for technology invented 
and implemented by Netscape.  

MaxDB is a trademark of MySQL AB, Sweden.   

SAP, R/3, mySAP, mySAP.com, xApps, xApp, and other SAP products and services mentioned herein as well as 
their respective logos are trademarks or registered trademarks of SAP AG in Germany and in several other 
countries all over the world. All other product and service names mentioned are the trademarks of their respective 
companies. Data contained in this document serves informational purposes only. National product specifications 
may vary.  

These materials are subject to change without notice. These materials are provided by SAP AG and its affiliated 
companies ("SAP Group") for informational purposes only, without representation or warranty of any kind, and 
SAP Group shall not be liable for errors or omissions with respect to the materials. The only warranties for SAP 
Group products and services are those that are set forth in the express warranty statements accompanying such 
products and services, if any. Nothing herein should be construed as constituting an additional warranty. 

SQL Server® is a registered trademark of Microsoft Corporation. 

WinFax® is a U.S. registered Trademark from Symantec Corporation. 

Sybase and SYBASE (logo) are trademarks of Sybase, Inc. 

Intel and Intel JPEG Library are trademarks of Intel, Inc. 

SEE4C (SMTP/POP3 Email Engine Library for C/C++) is the copyright of - MarshallSoft Computing, Inc. 

Victor Image Processing Library and VIC32 are trademarks of Catenary Systems. The Victor Image Processing 
Library is copyright material. This includes the source code, object code, dlls, examples, and documentation. This 
material is protected by United States copyright law as well as international copyright treaty provisions. 

THE APACHE SOFTWARE LICENSE, VERSION 1.1 

Copyright (c) 1999 The Apache Software Foundation.  All rights reserved. Redistribution and use in source and 
binary forms, with or without modification, are permitted provided that the following conditions are met: 

Redistributions of source code must retain the above copyright notice, this list of conditions and the 
following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution. 

The end-user documentation included with the redistribution, if any, must include the following 
acknowledgment: "This product includes software developed by the Apache Software Foundation 
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(http://www.apache.org/)." Alternately, this acknowledgment may appear in the software itself, if and 
wherever such third-party acknowledgments normally appear. 

The names "Xerces" and "Apache Software Foundation" must not be used to endorse or promote 
products derived from this software without prior written permission. For written permission, please 
contact apache@apache.org. 

Products derived from this software may not be called "Apache", nor may "Apache" appear in their 
name, without prior written permission of the Apache Software Foundation. 

 

THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION 
OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, 
OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE 
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

This product includes software developed by the Apache Software Foundation 
(http://www.apache.org/) and Info-Zip (http://www.info-zip.org/pub/INFO-ZIP/). 

This software consists of voluntary contributions made by many individuals on behalf of the Apache 
Software Foundation and was originally based on software copyright (c) 1999, International Business 
Machines, Inc., http://www.ibm.com.  For more information on the Apache Software Foundation, 
please see <http://www.apache.org/>. 

SAP and/or its distributors may offer, and charge a fee for, warranty, support, indemnity or liability 
obligations to one or more recipients of the software. However, SAP and/or its distributors may do so 
only on its/their own behalf, and not on behalf of the Apache Software Foundation or its contributors. 

UNZIP. This is version 2003-May-08 of the Info-ZIP copyright and license. The definitive version of this 
document should be available at ftp://ftp.info-zip.org/pub/infozip/license.html indefinitely.  

Copyright (c) 1990-2003 Info-ZIP. All rights reserved. 

For the purposes of this copyright and license, "Info-ZIP" is defined as the following set of individuals: 

Mark Adler, John Bush, Karl Davis, Harald Denker, Jean-Michel Dubois, Jean-loup Gailly, Hunter 
Goatley, Ian Gorman, Chris Herborth, Dirk Haase, Greg Hartwig, Robert Heath, Jonathan Hudson, 
Paul Kienitz, David Kirschbaum, Johnny Lee, Onno van der Linden, Igor Mandrichenko, Steve P. 
Miller, Sergio Monesi, Keith Owens, George Petrov, Greg Roelofs, Kai Uwe Rommel, Steve Salisbury, 
Dave Smith, Christian Spieler, Antoine Verheijen, Paul von Behren, Rich Wales, Mike White  

This software is provided "as is," without warranty of any kind, express or implied. In no event shall 
Info-ZIP or its contributors be held liable for any direct, indirect, incidental, special or consequential 
damages arising out of the use of or inability to use this software.  

Permission is granted to anyone to use this software for any purpose, including commercial 
applications, and to alter it and redistribute it freely, subject to the following restrictions:  

Redistributions of source code must retain the above copyright notice, definition, disclaimer, and this 
list of conditions.  

Redistributions in binary form (compiled executables) must reproduce the above copyright notice, 
definition, disclaimer, and this list of conditions in documentation and/or other materials provided with 
the distribution. The sole exception to this condition is redistribution of a standard UnZipSFX binary 
(including SFXWiz) as part of a self-extracting archive; that is permitted without inclusion of this 
license, as long as the normal SFX banner has not been removed from the binary or disabled.  

Altered versions--including, but not limited to, ports to new operating systems, existing ports with new 
graphical interfaces, and dynamic, shared, or static library versions--must be plainly marked as such 
and must not be misrepresented as being the original source. Such altered versions also must not be 
misrepresented as being Info-ZIP releases--including, but not limited to, labeling of the altered 
versions with the names "Info-ZIP" (or any variation thereof, including, but not limited to, different 
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capitalizations), "Pocket UnZip," "WiZ" or "MacZip" without the explicit permission of Info-ZIP. Such 
altered versions are further prohibited from misrepresentative use of the Zip-Bugs or Info-ZIP e-mail 
addresses or of the Info-ZIP URL(s). 

Info-ZIP retains the right to use the names "Info-ZIP," "Zip," "UnZip," "UnZipSFX," "WiZ," "Pocket 
UnZip," "Pocket Zip," and "MacZip" for its own source and binary releases.  

MarketSet and Enterprise Buyer are jointly owned trademarks of SAP AG and Commerce One.  

SAP, SAP Logo, R/2, R/3, mySAP, mySAP.com, and other SAP products and services mentioned 
herein as well as their respective logos are trademarks or registered trademarks of SAP AG in 
Germany and in several other countries all over the world.  All other product and service names 
mentioned are the trademarks of their respective companies. 

Copyright and Licensing Information for ACE(TM) and TAO(TM) 

ACE(TM) and TAO(TM) are copyrighted by Douglas C. Schmidt and his research group at Washington 
University, University of California, Irvine, and Vanderbilt University Copyright (c) 1993-2003, all rights 
reserved. Since ACE+TAO are open-source, free software, you are free to use, modify, copy, and 
distribute--perpetually and irrevocably--the ACE+TAO source code and object code produced from the 
source, as well as copy and distribute modified versions of this software. You must, however, include 
this copyright statement along with code built using ACE+TAO.  

You can use ACE+TAO in proprietary software and are under no obligation to redistribute any of your 
source code that is built using ACE+TAO. Note, however, that you may not do anything to the 
ACE+TAO code, such as copyrighting it yourself or claiming authorship of the ACE+TAO code that will 
prevent ACE+ TAO from being distributed freely using an open-source development model. You 
needn't inform anyone that you're using ACE+TAO in your software, though we encourage you to let 
us know so we can promote your project in the ACE+TAO success stories..  

ACE+TAO are provided as is with no warranties of any kind, including the warranties of design, 
merchantability, and fitness for a particular purpose, noninfringement, or arising from a course of 
dealing, usage or trade practice. Moreover, ACE+TAO are provided with no support and without any 
obligation on the part of Washington University, UC Irvine, Vanderbilt University, their employees, or 
students to assist in its use, correction, modification, or enhancement. However, commercial support 
for ACE is available from Riverace and commercial support for TAO is available from OCI and 
PrismTech. Both ACE and TAO are Y2K-compliant, as long as the underlying OS platform is Y2K-
compliant.  

Washington University, UC Irvine, Vanderbilt University, their employees, and students shall have no 
liability with respect to the infringement of copyrights, trade secrets or any patents by ACE+TAO or 
any part thereof. Moreover, in no event will Washington University, UC Irvine, or Vanderbilt University, 
their employees, or students be liable for any lost revenue or profits or other special, indirect and 
consequential damages.  

The ACE and TAO web sites are maintained by the Center for Distributed Object Computing of 
Washington University for the development of open-source software as part of the open-source 
software community. By submitting comments, suggestions, code, code snippets, techniques 
(including that of usage), and algorithms, submitters acknowledge that they have the right to do so, 
that any such submissions are given freely and unreservedly, and that they waive any claims to 
copyright or ownership. In addition, submitters acknowledge that any such submission might become 
part of the copyright maintained on the overall body of code, which comprises the ACE and TAO 
software. By making a submission, submitter agrees to these terms. Furthermore, submitters 
acknowledge that the incorporation or modification of such submissions is entirely at the discretion of 
the moderators of the open-source ACE+TAO projects or their designees.  

The names ACE(TM), TAO(TM), Washington University, UC Irvine, and Vanderbilt University, may not 
be used to endorse or promote products or services derived from this source without express written 
permission from Washington University, UC Irvine, or Vanderbilt University. Further, products or 
services derived from this source may not be called ACE(TM) or TAO(TM), nor may the name 
Washington University, UC Irvine, or Vanderbilt University appear in their names, without express 
written permission from Washington University, UC Irvine, and Vanderbilt University. 
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